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Siemens NX18 Tutoriel 

 

La pièce coudée 
 

Adaptation à NX 18 de notes du séminaire Drive-to-trial organisé par IBM et GDTech. 

 

Ce tutorial va vous aider à réaliser la pièce représentée sur la figure ci-dessous à partir de zéro. 

  

 
 
 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 – Introduction. 

Premièrement, ouvrez un nouveau fichier 

de type Model. 

• Dans la barre d’outils, sélectionnez 

New. 

• Dans la liste de filtre, sélectionnez 

Model. 

• Choisissez le nom du fichier et du 

dossier. 

• Cliquez sur OK pour confirmer. 

2 – Créer une extrusion. 

Avant de créer un volume via extrusion, 

vous devez sélectionner le plan dans 

lequel le profil va être dessiné. 

• Cliquez sur le bouton Sketch.  

• Créez une nouvelle esquisse et 

sélectionnez le plan XY dans la 

fenêtre Create Sketch. 

• Le plan XY apparait à l’écran. 
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Dessinez ensuite le cercle qui sera à la 

base de l’extrusion. 

• Cliquez sur le bouton Circle 

dans la barre d’outils. 

• Choisissez l’origine du repère 

comme centre du cercle. 

• Cliquez n’importe où pour définir le 

cercle. 

• Double-cliquez sur la contrainte de 

diamètre pour ouvrir une fenêtre. 

• Définissez le diamètre à 22 mm. 

• Cliquez sur Close pour accepter les 

changements. 

• Sortez du mode esquisse en cliquant 

sur  . 

• Cliquez sur le bouton Extrude 

. 

• La fenêtre Extrude apparait. 

• Choisissez ZC comme vecteur 

d’extrusion. 

• Imposez la distance de départ à 

0 mm et la distance de fin à 14 mm. 

• Cliquez sur OK pour confirmer. 

Manipulation des objets. 

1. Déplacer l’objet: maintenez Shift et le bouton 

central de la souris appuyé puis déplacez la souris. 

2. Rotation: maintenez le bouton central de la souris 

appuyé et déplacez-la. 

3. Zoom: faites tourner la molette. 
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3 – Créer une dépouille. 

• Cliquez sur le bouton Draft . 

• Dans le champ Draw Direction, 

sélectionnez le vecteur ZC. 

• Dans le champ Draft References, 

sélectionnez comme Stationary Face 

la base du cylindre incluse dans le 

plan XY. La Stationary Face 

représente celle qui ne sera pas 

modifiée par l’opération. 

• Sélectionnez la face latérale du 

cylindre comme Face(s) to Draft. 

• Cliquez sur la flèche jaune pour 

inverser le sens de la dépouille si 

nécessaire (celle-ci doit être dirigée 

vers l’intérieur du cylindre) 

• Imposez un angle de 3 degrés et 

visualisez votre angle de coupe. 

• Cliquez sur OK pour créer l’objet s’il 

convient (le solide devrait être plus 

fin sur le dessus). 

1. Face latérale 

2. Base du cylindre 

dans le plan XY 

3bis – Désactivez l’Auto Dimensioning. 

A partir de maintenant, assurez-

vous que le Continuous Auto 

Dimensioning est désactivé lorsque 

vous créez une esquisse. Cette 

option n’est disponible que quand 

vous vous trouvez dans un sketch. 

• Dans la barre d’outils, cliquez sur 

More et désactivez le Continuous 

Auto Dimensioning. 
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4 – Créer une seconde extrusion.  

Vous devez d’abord créer un profil qui 

sera utilisé pour l’extrusion. Désactivez 

le Continuous Auto Dimensionning. 

• Créez une nouvelle esquisse dans le 

plan XY. 

• Utilisez le bouton Profile  et 

tracez successivement des Line et 

des Arc à l’aide de la fenêtre Profile, 

construisez approximativement le 

contour oblong ci-contre. Vous 

pourriez voir apparaître certains 

symboles sur vos constructions. 

Certaines seront utiles et d’autres 

contreproductives, comme celle-ci. 

Elle oblige votre droite à rester 

horizontale. Cliquez dessus et 

supprimez là si vous la voyez. 

• Imposez une contrainte de tangence 

à chaque connexion entre un arc et 

une ligne. Pour ce faire, sélectionnez 

un arc et une ligne (CTRL + clique 

gauche) et cliquez sur Tangent dans 

le menu qui apparait. Une fois la 

contrainte de tangence mise, vous 

verrez un symbole apparaître. 

• Ouvrez la fenêtre Geometric 

Constraints en cliquant sur le bouton 

More puis Geometric Constraints. 

Vous aurez ici bon nombre de 

contraintes utiles. Avec l’expérience, 

vous pourrez vous passer de cette 

page et les faire directement sur le 

dessin. 

 

 

 

 

• Dans la fenêtre Geometric 

Constraints sélectionnez la 

contrainte Point on Curve. Cette 

contrainte force un point à se trouver 

le long d’une ligne indiquée. 
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• Sélectionnez le centre de l’arc de droite 

ainsi que l’axe x et validez. 

• Ajoutez deux contraintes additionelles 

Point on Curve  en sélectionnant le 

centre de l’arc de gauche et l’axe x puis 

à nouveau le centre de l’arc de gauche 

et l’axe y. Vous devriez obtenir quelque 

chose de similaire à la figure ci-contre. 

 

Ensuite, imposez la distance entre les  

deux centres des arcs. 

• Cliquez sur le bouton Rapid 

Dimension  puis sélectionnez les 

deux centres des arcs dans la fenêtre 

Rapid Dimension, imposez une 

longueur de 20 mm. 

 

Pour finir, imposez les rayons des arcs 

 

• Sous le bouton Rapid Dimension, 

sélectionnez Radial Dimension. 

 

 

 

 

 

 

 

 

 

• Imposez un rayon de 14 mm pour l’arc 

de gauche et 8 mm pour l’arc de droite.  

• Quittez le mode Sketch ( ) 

• Créez une extrusion ( ) de 10 

mm à partir du profil que vous avez 

dessiné. 
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5 – Créer une seconde dépouille.  

Vous allez créer une dépouille identique à 

celle réalisée sur le cylindre sur la seconde 

extrusion 

• Sélectionnez la face B comme indiqué sur 

la figure. 

• Sélectionnez la face interne comme face 

de référence (la face arrière par rapport à 

la figure). 

• Appliquez en cliquant sur OK. 

Une nouvelle dépouille est ainsi appliquée à la 

seconde extrusion.  

B 

6 – Créer un trou.  

• Cliquez sur le bouton Hole . 

 

Dans la fenêtre Hole, vous devez spécifier le 

centre du trou, que l’on placera à l’origine.  

• Dans le champ Position, cliquez sur le 

bouton Sketch Section. 

 

Une nouvelle fenêtre Create  

Sketch permettant de créer une esquisse  

pour le trou apparait. 

• Sélectionnez le dessus du cylindre comme 

plan de référence puis cliquez sur OK. 
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• Le plan dans lequel le trou va se trouver 

est défini. Dans la nouvelle fenêtre 

Sketch Point, cliquez sur le bouton 

Point Dialog. 

 

• La fenêtre Point s’ouvre. Assurez vous 

que les coordonnées Output 

Coordinates X, Y et Z sont toutes à 0 et 

cliquez sur OK. 

 

 

• Fermez la fenêtre Sketch Point et 

quittez l’esquisse en cliquant sur le 

bouton Finish Sketch . 

 

 

 

 

 

 

 

 

• Maintenant, le champ Position de la 

fenêtre Hole devrait contenir un 

Specified Point. 

• Dans le champ Form and Dimension, 

sélectionnez Simple Hole comme 

forme, un diamètre de 12 mm et la 

limite de profondeur Until Next.  
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7 – Congé de raccordement. 

• Cliquez sur le bouton Edge Blend 

. 

• Sélectionnez les quatre bords 

supérieurs du contour oblong. 

• Définissez un rayon de 1 mm et 

cliquez sur OK pour confirmer. 

• Répétez l’opération pour les bords 

supérieurs entre le cylindre et le 

contour oblong. 

8 – Copie symétrique de la pièce.  

Comme la pièce est symétrique, il est 

plus simple de dessiner une moitié et de 

dupliquer le volume. 

• Cliquez sur le bouton Menu, puis sur 

le bouton Insert→Associate 

Copy→Mirror Geometry. 

 
 

• Sélectionnez l’objet que vous avez et 

choisissez le plan XY comme Mirror 

Plane. 

• Cliquez sur OK dans la fenêtre qui 

apparait. 

Pour finir, unifiez l’objet avec sa 

symétrie en cliquant sur le bouton 

Unite.  
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9 – Créer une troisième extrusion.  

• Sélectionnez le plan XZ et entrez dans le 

mode esquisse. Veuillez à ce que la 

verticale de votre plan soit dans le même 

sens que le vecteur Y du repère général. Si 

ce n’est pas le cas, faite un double clic sur 

la verticale pour en changer le sens. 

• Dans l’esquisse, créez un cercle centré à 

l’origine. 

• Imposez une contrainte de 15 mm pour le 

diamètre du cercle. 

• Sortez du mode esquisse et cliquez sur le 

bouton Extrude . 

• Dans la fenêtre qui vient de s’ouvrir, 

sélectionnez Unite dans le champ Boolean 

et sélectionnez l’objet que vous avez 

réalisé. 

• Spécifiez l’axe YC comme Direction 

Vector. 

• Définissez la distance de départ à 10 mm. 

• Définissez la distance de fin à 24 mm. 

• Cliquez sur OK pour confirmer. 
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10 – Créer un trou. 

• Cliquez sur le bouton Hole . 

• Créez une esquisse pour définir la 

position du trou. Cette fois, le plan 

d’esquisse est la face supérieure du 

cylindre que vous venez d’extruder. 

• Dans la fenêtre Point, assurez-vous que 

les coordonnées Output Coordinates 

X, Y et Z sont mises à 0. Attention, dans 

certains cas, un second point se 

sélectionne.  

• Faites un trou de 8 mm de diamètre et 

15 mm de profondeur. 

• Choisissez Cylinder Bottom pour le 

champ Depth To. 

 

• Cliquez sur le bouton Edge Blend 

 et sélectionnez le coté du 

cylindre du dessus. 

• Définissez le rayon du congé de 

raccordement à 1 mm. Veuillez à ce que 

les contours soient fermés. 

• Confirmez. 

• Effectuez la même opération pour le 

bord à la jonction du cylindre avec le 

corps. 

11 – Créer un raidisseur. 

Les raidisseurs sont utilisés pour raidir 

les pièces sujettes à des contraintes 

mécaniques. 

• Entrez dans le mode esquisse et 

sélectionnez le plan XY. 

• Désactivez l’option Continuous Auto 

Dimensioning.  

• Cliquez sur le bouton Line  et 

dessinez une ligne oblique arbitraire 

comme ci-contre. 
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• Sortez de l’esquisse et cliquez sur le 

bouton Rib  dans 

Menu→Insert→Design Feature. 

• Dans la fenêtre Rib, définissez 

comme Target l’objet que vous avez 

créé. Choisissez comme Section la 

droite que vous venez de dessiner.  

• Dans le champ Walls, sélectionnez 

l’option Parallel to Section Plane, 

avec Dimension défini sur 

Symmetric. 

• Définissez la Thickness à 2 mm et 

assurez-vous que l’option Combine 

Rib with Target est active. 

• Pour finir, cliquez sur OK pour 

valider la création du raidisseur. 

• Note: si vous ne parvenez pas à 

sélectionner les faces désirées, 

regardez si le Selection Rule est sur 

SingleFace

 

Vous allez maintenant arrondir les bords 

du raidisseur. 

• Cliquez sur le bouton Face Blend 

 situé sous le bouton Edge 

Blend . 

• Dans la fenêtre Face Blend, 

sélectionnez le type Three-face. 

Comme faces 1 et 2, sélectionnez les 

deux faces verticales du raidisseur. 

• Comme face du milieu, la dernière 

face visible du raidisseur. 

• Cliquez sur OK pour valider. 
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La dernière étape consiste à rajouter un 

congé de raccordement à la junction 

entre le raidisseur et la pièce. 

• Cliquez sur le bouton Edge Blend 

button  (sous le bouton Face 

Blend). 

• Sélectionnez le bord du raidisseur (la 

jonction entre le raidisseur et le 

cylindre du dessus). 

• Choisissez un rayon de 1 mm, et 

cliquez sur OK pour confirmer. 

12 – Créer une coupe. 

Vous allez dessiner une forme 

rectangulaire et l’utiliser pour couper la 

pièce. 

• Sélectionnez le plan XZ et entrez 

dans le mode Sketch. Attention au 

vecteur normal. 

• Dessinez un rectangle 

approximativement comme ci-contre 

(2 clics pour les extrémités du 

rectangle) en utilisant le bouton . 

• Cliquez sur le bouton More  

et sélectionnez Geometric 

Constraints dans le champ Sketch 

Constraints.  

• Dans la fenêtre, sélectionnez Point 

On Curve comme contrainte. 

• Comme Object to Constraint, 

sélectionnez le milieu d’un bord 

vertical du rectangle. 

• Comme Object to Constraint to, 

sélectionnez l’axe x. 
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• Cliquez sur le bouton Rapid 

Dimension  et contraignez la 

longueur et la largeur du rectangle, 

respectivement, à 20 mm et 6 mm. 

• Dans la fenêtre Rapid Dimension, 

sélectionnez un point du rectangle et 

un point de l’objet comme montré ci-

dessous. Imposez une distance de 

10 mm entre ces points.  

• Sortez du mode esquisse. 

• Cliquez sur le bouton Extrude 

. 

• Assurez-vous que l’axe YC est dans 

le champ Direction. 

• Dans le champ Limit, sélectionnez 

comme valeur End, Symmetric Value 

et 24 mm comme Distance. 

• Pour finir, choisissez Substract pour 

le champ Boolean. 

• Cliquez sur OK pour confirmer. 
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13 – Créer un trou.  

Vous allez maintenant créer un trou 

coaxial dans la pièce. 

• Cliquez sur le bouton Hole . 

Comme précédemment, dessinez 

l’esquisse qui définit la position du 

trou. 

• Dans la fenêtre Create Sketch, 

sélectionnez le plan de référence 

comme face 1. 

• Dans la fenêtre Point, sélectionnez 

l’option Arc Ellipse/Sphere Center 

dans le champ Type.  

• Pour spécifier Point Location, 

cliquez sur l’arc de droite du contour 

oblong extrudé. 

• Dans la fenêtre Hole, choisissez un 

diamètre de 6 mm et choisissez  

Through Body pour la limite de 

profondeur. 

• Confirmez en cliquant sur OK. 

1 
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14 – Modification de la géométrie.  

Vous avez presque terminé mais vous 

remarquez que vous avez fait une erreur 

concernant le premier arc du profil 

oblong. Il doit mesurer 13mm et non 

14mm ! 

• Double cliquez sur l’esquisse 

correspondant au contour oblong 

dans l’arbre à gauche de l’écran 

(Part Navigator). 

• Doublez cliquez sur les dimensions 

de l’arc de gauche du contour oblong 

et remplacez la valeur de 14 mm par 

13 mm. 

• Confirmez en cliquant sur OK. 

• Sortez du mode esquisse. 

• Le programme calcule 

automatiquement les changements 

subséquents à effectuer. 

• La géométrie est mise à jour et tient 

compte de votre changement. 

15 – Ajouter un matériau à la pièce. 

Ajouter un matériau à la pièce permet 

d’avoir un rendu plus réaliste mais 

associe également les propriétés du 

matériau à la pièce pour, par la suite, 

réaliser un calcul de contraintes 

mécanique sur celle-ci. 

• Cliquez sur le bouton Assign 

Materials  situé 

dans Menu→Tools→Materials. 

• Dans la fenêtre Assign Materials, 

choisissez votre pièce. 

• Cliquez sur le matériau Iron_40 dans 

la liste. 

• Cliquez sur OK pour confirmer. 

• Dans l’en-tête de la barre d’outils, 

cliquez sur View. 

• Dans la nouvelle barre d’outils, 

cliquez sur le bouton True Shading 

. 
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16 – Déplacer l’objet. 

Vous venez de remarquer que vous avez 

utilisé le mauvais plan durant le design 

de la pièce. Le plan du sol doit se trouver 

sous la pièce. 

Pour corriger cela, vous allez tourner 

l’objet de 90° autour de l’axe x. 

• Cliquez sur le bouton Move Object 

 sous  

Menu→Edit. 

• Dans la fenêtre Move Object, 

choisissez Angle pour le champ 

Motion, définissez le vecteur de 

rotation comme XC et l’Axis Point 

comme l’origine. 

• Pour finir, choisissez un angle de 90° 

et assurez-vous que Move Original 

est sélectionné. 

• Cliquez sur OK pour valider. 

 

S’il vous est impossible de faire 

bouger la pièce: il est possible 

qu’une erreur quelque part en soit la 

cause. Cliquez sur la petite fleche ici, 

cochez Associative puis décochez 

Move parents. Cela devrait vous 

permettre de faire bouger votre 

pièce. 


